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1. Introduction
This document is the user guide for Release 2 of the Swift version of  TAKO. TAKO (Timeline Assembler, Keyword Oriented) is a GOTS suite of software initially developed by a group in the Laboratory for High Energy Astrophysics at the Goddard Space Flight Center for scheduling spacecraft science observations.  It was adapted and modified for use on the Swift mission. 

In this section, we describe scheduling concepts and terminology that may be unique to TAKO or to the Swift mission.  The second section describes how to bring up the application and the input and output files. The next section walks through a typical daily scheduling session and tells how to use TAKO to do the various tasks.  The final section describes the features of the user interface. 

1.1 Context
The purpose of TAKO is to take a candidate observation list and produce an observation schedule.  The observations are scheduled so that safety constraints are not violated, the high priority targets are more likely to be scheduled, and all of the available time is filled.  The resulting schedule contains a time-tagged list of preplanned target (PPT) pointings (or snapshots) which is called the preplanned science timeline (PPST). The PPST file is input to the mission planning system (MPS) which creates the stored command load that includes for each snapshot in the schedule an FOPPTREQUEST command that requests an observation of a target.  Finally, the stored command load is uplinked to the spacecraft where each FOPPTREQUEST command is executed at the scheduled time.  (What the FOM actually does with the FOPPTREQUEST command when it receives it is described in another document.)
1.2 TAKO Concepts and Terminology
The user interacts with TAKO through a graphical user interface. The diagram in Figure 1.2-1 illustrates the components of TAKO that the user will be aware of.
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Figure 1.2-1 TAKO Data and Control Flow Diagram

The user inputs the observation list (also called "target list") that the scheduler uses.  The observation list is a set of observation segment definitions created and modified in the Target Database Editor function. An observation segment definition contains parameters that define the target, spacecraft roll, and instrument modes.  A target is a distinct location in the sky defined by a right ascension and declination (RA/Dec) pair. Each target is identified by a unique 24-bit target identification number provided to TAKO by the user. The user must also assign a unique 8-bit segment number for each new observation of a target.  The target ID and the segment number are combined to form the observation number. Refer to SWIFT Observation Definition Memorandum, 410.4-AGMT-0011, for details. An observation segment definition also includes guidelines for the scheduler, including the length of time the target should be observed and the priority of the segment.  
The main panel of the TAKO user interface, shown in Figure 1.2-2, contains the schedule timeline, the target viewer, and a status message display. The schedule timeline shows parallel plots of the currently scheduled target snapshots, the constraint curves, and other scheduling information.  A snapshot is a portion of an observation that can be made while observation constraints are not violated. The period during which none of the observation constraints are violated is called a "goodtime" period.  Several snapshots are scheduled to complete an observation segment. An observation segment is considered complete after a series of scheduled snapshots accumulates the desired amount of time on the target. 

The schedule timeline will plot snapshots that are within the current scheduling period.  The scheduling period contains two sections: the reference period (shaded box) and the window of interest. You cannot unschedule or schedule snapshots during the reference period since it is outside of the window of interest.  It's just there to provide continuity. The window of interest is the range of time in which the schedule can be changed and it is the range of time that the preplanned science timeline (PPST) will be generated from.  The scheduling period and window of interest time ranges are saved in the target database.

The constraint curves are computed using the current ephemeris file and the constraint definitions. The constraint definitions are read from the current target database.  The constraint parameters can be changed by the user if necessary using the Target Database Editor.
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Figure 1.2-2. TAKO Main Display

The target viewer is a tabular list of the observations in the target database.  The user selects an observation from the target viewer, then TAKO plots the constraint values specific to that observation.  The status message display, called Info box by TAKO, shows time-stamped messages that indicate the progress of TAKO's processing.  These messages are also stored in a file.
The TAKO supports both interactive and automated scheduling of observations.  Interactive scheduling allows the user to select a target from the list and click on the timeline at the desired starting point of the observation.  Individual snapshots are placed by the scheduler during "goodtime" periods that are not occupied by other target's snapshots.)   The automated scheduling function (or autoscheduling) schedules many observations by chooses the starting time automatically based on user-supplied guidelines. Use of autoscheduling is recommended so that the snapshots can be placed as closely together as possible. The user can combine interactive and autoscheduling by manually placing a few targets and then autoscheduling the remainder.  

Although the autoscheduler has user-supplied parameters, the recommended parameter values for Swift are to schedule all the targets shown in the Target Viewer starting at the beginning of the window of interest, and that observations with high priority values are scheduled first. The autoscheduler creates a list of unscheduled or partially scheduled observations.  Any completely scheduled observation as well as any "manually" scheduled observation is not included in this list; they remain unchanged by the autoscheduler.  The autoscheduler attempts to schedule the highest priority observation at the first available "goodtime" that is not occupied by another observation.  The entire observation is scheduled before going on to the next highest priority observation. The process is repeated until it schedules all the observations that can be scheduled within the window of interest.  Sometimes the observation can only be partially scheduled.  The autoscheduler schedules as many snapshots for an observation as it can within the window of interest, and the remainder of the observation time will be scheduled during the next day's session.  (The legacy version of TAKO would not partially schedule an observation.)
A target database can be in one of three schedule states: Working, Alternate, and Approved. You will normally start the scheduling session with the most recent Approved database, then update the time range and save the file, using Save As, as a new Working database.  You can modify the observation list, or change constraints, and then create schedules.  You may overwrite the Working database with your changes. Once you are happy with the schedule, you write the PPST file.  This puts the database into the Alternate state. TAKO will not allow you to overwrite this target database file.  You can try other scheduling scenarios by either continuing with this database (after saving it in a new file) or by going back to start over with the Approved database.  You may have several alternate databases for the same time period but they all must trace their heritage to the Approved database.  Finally, you develop the best schedule and approve it.  The database is put in the Approved state and TAKO transfers the PPST, along with the associated target database and Master PPSTs, to the MOC Closed subnet.  Your next scheduling session must start with this database to preserve observation continuity.
When the PPST and target database files received on the MOC Closed subnet they are placed in the MOC fileserver where they are available for use by MPS and the Timeline Monitor, and are posted to the MOC Web Site.

2. TAKO Data Files
This section describes the input and output data files used by TAKO.
Table 2-1. Input Files
	File
	Description

	Target Database
	targets, constraints, and schedule

	Spacecraft Ephemeris 
	predicted s/c positions and rates from STK

	tako.init
	Mission configuration file – customizes TAKO for Swift

	~/.takorc 
	TAKO user preference file – panel colors (optional)

	~/.takoSession
	TAKO session file – saves session settings  (optional)

	Target CSV file
	Observation definitions in comma-separated-value format, used for creating or adding to target database. (optional)


Table 2-2. Output Files
	File
	Description

	New or Updated Target Database file
	updated targets, constraints, and/or schedule

	Preplanned Science Timeline (PPST)
	Scheduled events for MPS (window of interest only)

	Master Preplanned Science Timeline (PPST)
	Scheduled events for Timeline Monitor (longer time period)

	Archived Master Preplanned Science Timeline (PPST)
	Previous Master PPST file

	Database Report
	Human-readable listing of the target database content plus schedule statistics. (optional)

	Target CSV file
	Observation definitions in comma-separated-value format. (optional)

	Log file
	saves all the messages sent to the info box 


2.1.
 Input File Descriptions
2.1.1.
Target Database File

The Target Database is described in Science Target Database Design 06-19-02.doc (or most recent version).  At a minimum, the target database contains the time range of the scheduling window, the name of the STK ephemeris file, the observation segment definition records, scheduling rules, and constraint definition records.  When observations have been scheduled, the snapshot records are also stored.  When a PPST is generated, the PPST file name is saved in the currently loaded target database.  Thus each PPST is associated with a target database.  This allows PPT request commands to be traced to the scheduling conditions that created it.  

Technically, this file is optional, but practically, it is required.  You will nearly always be starting a scheduling session based on the previous session's schedule.  Otherwise, a constraint may be unwittingly violated because we didn't have the continuity with the previous set of PPTs that were uplinked (e.g., the 500 degree/orbit slew constraint)
The default location of all Target Database files is the TAKO data directory specified in the tako.init file.

2.1.2.
STK Ephemeris File

The ephemeris file is the basis of constraint calculations.  It contains the Cartesian position, latitude and longitude, and the RA and Dec of the velocity vector of the spacecraft at one minute intervals.  The ephemeris file is produced by Satellite Toolkit (STK) software configured for Swift.  Whenever the spacecraft vector is updated, a new ephemeris file will be transferred to the ephemeris directory on the SOT workstation.  The location of the ephemeris directory is specified in the tako.init file.  The name of this directory must be coordinated with the configuration file for the STK Automation software because it transfers the file to the SOT workstation.

The filename of the ephemeris used to create the constraints for a schedule is saved in the current target database.   When you load a target database, the associated ephemeris file will be automatically read.

Filename Convention

STK_EPH_yyyyddd_yyyyddd_vv.txt

Where: yyyy is the 4-digit year 

ddd is 3-digit day of the year (001 – 366) 

vv is a version number

The two dates indicate the start and end dates of the ephemeris data contained in the file.

The version number (initial version is 00) is incremented for subsequent versions of the file generated for the same time range of data.  It is a good idea to use the highest version of the file for a certain date range.

2.1.3.
TAKO configuration file
The TAKO configuration file contains values that customize TAKO for Swift.  It also contains values for parameters that may change as the mission progresses.  The values are in the configuration file so that they can be changed without modifying the code.  As delivered, the TAKO configuration file is in the TAKO data directory.

Figure 2.1.3 shows the beginning of configuration file as it is delivered in Release 2.  The part that it not shown is not relevant to Swift or will never be changed without a software delivery.
#  CVS info - $Id: tako.init,v 2.6 2002/11/26 20:18:02 mmix Exp $ $Name:  $

#

# File: tako.init

#

# Description: Mission configuration parameters for TAKO

#

# Modified for Swift's version of TAKO

#

# Any line starting with a # is considered a comment and ignored.

#

# Configuration fields are:   

#      Key       | Value | (optional) comments

# ----------------START OF USER CHANGEABLE PARAMETERS

# 

#    The user may change the values in this section as needed 

#    to achieve good scheduling results.

#    Refer to the TAKO User Guide.

#

#   Default snapshot minimum and maximum duration.

#   These values are used only if no min and max are given for the observation.

#   Enter value and units.  Default unit is days.

MinSSduration | 3  minutes | Set minimum duration to est. max. slew time

MaxSSduration | 40 minutes | Determined by UVOT maximum

#   Target types for the target database - used in menus and reports

TargetTypes | Prime, Fill-in, BAT survey, GRB, Calibration, BAT catalog, Non-GRB | Menu items

Continuity | 1 day | default for schedule plot continuity.

#                    e.g., plot starts 1 day before window of interest

#   Slew resource specifications

#   Used to limit the amount of slewing that occurs in a time period

#   Current values limit slewing to 450 degrees per orbital period.

MaxSlewPerPeriod   |  450.0 |   in degrees

SlewPeriod 
   |  97.0  |   the orbit period in minutes

SlewRestrictSched  |  yes   |  yes: don't allow schedule to deplete resource, 

#                               no: resource is just info

#

#  Target ID and segment number valid range

#    Based on Swift Observation Definition memo - 410.4-AGMT-0011

TargetIdValid     | 10000-39999,50000-79999 |  no blanks

SegmentValid      | 1-253 |

#

#    CAUTION:

#    TakoData, EphemDir, Fileserver and FileserverDB are set by installer

#    and should not be changed by the user without concurrence from

#    the system administrator.

TakoData | $TAKO/lib/data | Default TAKO data directory;

#                           holds target databases, and PPST files

EphemDir | $FS_STK_PRODUCTS |  Ephemeris file directory

#   Master PPST file configuration values

#     Coordinate changes to MasterPPST and MasterPPSThistory

#     with any changes to the Timeline Monitor configuration file.

FileserverDB | $FS_TARGET_DB  | Path to the science database directory

Fileserver   | $FS_PLAN_PPSTL | Path to the science timeline directory

MasterPPST   | MasterPPST.txt | Base file name of the Master PPST file

MasterPPSThistory | 7         | Number of days of PPST history to maintain 

#                               in the Master PPST file

# ----------------END OF USER CHANGEABLE PARAMETERS

#==========================================================================

#    DO NOT CHANGE

#       without concurrence from software developers

#==========================================================================

Project_Name     | Swift | 

Accuracy         | 1     |  schedule resolution, in minutes

Rough_Resolution | 1     |  initial plot res, in minutes

# converting between our data and the internally required keys and units

UniqueID_Keyword     | obs_number | 

RA2000_Keyword       | RA degrees | 

Dec2000_Keyword      | dec degrees | 

ExposureTime_Keyword | duration days |  

#Boresight | 1.0 0.0 0.0| an optional way to define a main boresight

# this field is optional, if efficiency graphs should bear a label

# other than the usual UniqueID (for example, the target name)

IndividualGraphLabel_Keyword | target_name | 

# Snapshot overheads

# For Swift there will be overhead for each snapshot, not just for 

# the start of the observation.

Overhead | mnv,Front,1,0,min,yes,slewGreatCircle,0,0,yes,0.785 deg/sec| mnv before obs
# 1. An overhead named "mnv" is applied to the beginning of the snapshot. 

# 2. Priority is 1

# 3. No flat time is applied. 

# 4. flat time units is minutes

# 5. Overhead does use goodtime. not sure what this means

# 6. Use slewGreatCircle proc to compute the overhead time

# 7. No Minimum overhead duration

# 8. No Maximum overhead duration

# 9. slewGreatCircle proc needs the target position to compute the overhead

# 10. Two additional parameters to slewGreatCircle: 

#       Slew rate: float value

#       Slew rate units: e.g., deg/min, deg/sec

#   MOC to SDC ICD - PPST entry and exit labels must be "Begin" and "End"

Optional_In_State | Begin |

Optional_Out_State | End |

# The ephemeris file name is obtained from the target database

# Swift assumes only one type of ephemeris file.

Ephem_Type  | xyzll_eph |  which subroutine reads it in

Ephem_Units | 1.0 |  converts ephem units to km

Ephem_Resolution | 1 | in minutes, usually same as Accuracy

#   Slew Rate (might not be needed)

SlewRate | 0.785 | Nominal PPT slew rate (deg/sec) for computing slew time (from Igor Lazbin's email)

#Optional_Zoom_Type | 1 | quantized
Figure 2.1.3. TAKO Configuration File
The configuration file is grouped into user-changeable parameters, rarely-changed parameters, and user-must-not-change parameters. The user may change the values in the first section as needed to achieve good scheduling results. The second section should not be changed except in rare circumstances and not without direction from the software maintainer or system administrator.  The remainder of the parameters must never be changed by the user.  The only exception might be the overhead specification, the slew rate may need to be tweaked if the maneuver times are not good estimates of the actual slew times.  

The syntax of the configuration record is:

Keyword | Value | Comment

The fields are separated by vertical bars (or pipes).

These tables explain the purpose of each keyword and specify its valid values. 
Table 2.1.3-1. User-changeable Parameters
	Key Word
	Default value
	Description

	MinSSduration 
	 3  minutes 
	Default minimum snapshot duration. The scheduler will not schedule snapshots that are shorter than this value.
Enter value and units. If the units are not given then TAKO assumes the value is days.

This value is used as the default for SSmin field in the Edit Observation panel. 

Currently, the default is the estimated maximum slew time.  Could be larger to avoid wasted slews, but may result in more unscheduled times that could cause safepoints.

	MaxSSduration 
	 40 minutes 
	Default maximum snapshot duration. The schedule will not schedule snapshots that are longer than this value.

Enter value and units. If the units are not given then TAKO assumes the value is days.

This value is used as the default for SSmax field in the Edit Observation panel. 

The current default value is determined by the maximum snapshot duration that UVOT can handle.

	

	TargetTypes 
	Prime, Fill-in, 
BAT survey, GRB, Calibration, 

BAT catalog, Non-GRB 
	Target types for the observation definitions in the target database.  

A comma-separated list of text strings.  Spaces are allowed. 
Target types used to assign observations to groups.  The scheduler currently does not distinguish target types except that it can unschedule targets according to type. The values are used in the Unschedule menu, the Type menu in the Edit Observations panel, and in the database report.  This list will also be used to validate the type field in imported target files.

	
	
	

	Continuity 
	 1 day 
	Default for schedule continuity. 
Enter value and units. If the units are not given then TAKO assumes the value is days.

With the default value, the schedule period (and plot window) starts 1 day before window of interest.

	                  

	Slew resource specifications - Used limit the amount of slewing that occurs in a time period

	MaxSlewPerPeriod   
	  450.0 
	Maximum cumulative slew angle during the period of time specified by SlewPeriod.

Units in degrees.
Current value limits slewing to 450 degrees per orbital period.

	SlewPeriod 
   
	  97.0  
	Length of the time period in minutes..

For Swift, we use the orbit period.

	SlewRestrictSched  
	  yes   
	Constraint flag.

yes: use slew resource to constrain scheduling. Don't allow a snapshot to be scheduled if it causes slew to exceed the MaxSlewPerPeriod. 

no: resource is just plotted for info

	

	Target Id and segment valid ranges are based on Swift Observation Definition memo - 410.4-AGMT-0011

	TargetIdValid     
	10000-39999,50000-79999 
	Target ID valid range.
List of comma-separated numeric ranges.  No blanks are allowed in the list.

	SegmentValid      
	 1-253 
	Segment number valid range. 
List of comma-separated numeric ranges.  No blanks are allowed in the list.


Table 2.1.3-2. Rarely changed parameters

	Key Word
	Default value
	Description

	TakoData 
	 $HOME/TAKO.data
	TAKO data directory.

This is where the target database files and PPST files are stored.

	EphemDir 
	 $FS_STK_PRODUCTS 
	Ephemeris file directory.  Must be coordinated with the STK Automation configuration file.

	FileserverDB 
	 $FS_TARGET_DB  
	Path to the science database directory.  Target database files are stored here after they are approved

	Fileserver   
	 $FS_PLAN_PPSTL 
	Path to the science timeline directory.  PPST, Archive Master PPST,  and Master PPST files are stored here after they are approved

	

	Master PPST file configuration values: MasterPPST and MasterPPSThistory values must be coordinated with the values the Timeline Monitor configuration file.

	MasterPPST   
	 MasterPPST.txt 
	Base file name of the Master PPST file

	MasterPPSThistory 
	 7         
	Number of days of PPST history to maintain in the Master PPST file.  


2.1.4.
TAKO user preferences file (.takorc)
The .takorc contains the user preferences for the TAKO panel colors. The .takorc is not required to start TAKO. It is created in the user's home directory when the user selects the Save Colors menu option.  When the file is present, TAKO uses the specified colors when displaying the TAKO window. Otherwise, the tasteful default colors are used. If you want to get the default colors back, simply delete the .takorc file.  See the User Preferences section for details.
2.1.5.
TAKO session file (.takoSession)
The Tako Session File contains the state of the TAKO session when TAKO is shut down normally via Quit or Save and Quit menu options. The .takoSession file is not required to exist when TAKO starts. The TAKO session state includes the settings of the Autoscheduler Panel and the name of the current Target Database File when TAKO is shut down. When TAKO is started again, the Target Database File you last accessed is loaded and the autoscheduler panel settings are set to the ones you were using.

The session file also saves the time, user name, and full path name of the version of TAKO that was last used.  These values are useful for troubleshooting.

2.1.6.
Target CSV file

Observation segment definitions can be imported to and export from TAKO using a comma-separated-value (CSV) text file.  The file can be created from or input to any application that can handle a CSV-format file, such as a database, spreadsheet program or a planning tool.  
The file must contain a heading line followed by data lines:   The fields are described in Table 2.1.6.
Table 2.1.6. Target CSV Fields

	Heading
	Field Description

	target_name
	Human-friendly name of the target (can contain spaces, but not commas)

	type 
	Observation Type: e.g. GRB, BAT survey, Fill-in

	target_ID
	Target identification number (decimal)

	segment
	Observation segment number (decimal)

	FoM
	Figure of Merit value

	RA
	Right Ascension in degrees

	dec
	Declination in degrees

	roll
	Roll in degrees

	BATmode
	BAT instrument mode

	XRTmode
	XRT instrument mode

	UVOTmode
	UVOT instrument mode

	duration           
	Observation duration in seconds, how much cumulative time to schedule for this observation. 

	comment
	Text (can contain spaces, cannot contain commas)

	priority            
	Scheduling priority (0-99)  (or initial priority for declining priority formula)

	slope
	Slope for the declining priority formula 

	epoch
	Epoch time for the declining priority formula

	SSmin
	Minimum snapshot duration in seconds

	SSmax
	Maximum snapshot duration in seconds


The headings must be exactly as documented above because they match keys in the Target Database. The keys are case-sensitive. See the Target DB description for more details on the field contents.

Filename Convention:

Filename extension must be .csv

Example: new_targets_2002165.csv

Sample file:

target_name,type,target_ID,segment,FoM,RA,dec,roll,BATmode,XRTmode,UVOTmode,duration,comment,priority,slope,epoch,SSmin,SSmax, 

GRB000911,GRB,12,2,100,34.67,7.8,0,0,0,0,100000.0,Planning Exercise,100,0,,

Cen A,BAT,31,2,100,201.37,-43.02,0,0,0,0,50000.0,Planning Exercise,30,0,,

GRB001007,GRB,13,2,100,61.47,-21.9,0,0,0,0,20000.0,Planning Exercise,100,0,,

EXS 1737.9-2952,BAT,32,2,100,264.48,-29.87,0,0,0,0,100000.0,Planning Exercise,30,0,,

3C 120,BAT,14,2,100,68.3,5.35,0,0,0,0,100000.0,Planning Exercise,80,0,,

GRO J1719-24,BAT,33,2,100,259.94,-24.97,0,0,0,0,100000.0,Planning Exercise,30,0,,

3C 390.3,BAT,15,2,100,280.56,79.76,0,0,0,0,100000.0,Planning Exercise,80,0,,

Nova Per 1992,BAT,34,2,100,65.43,32.91,0,0,0,0,100000.0,Planning Exercise,30,0,,

3C 273,BAT,16,2,100,187.28,2.05,0,0,0,0,100000.0,Planning Exercise,80,0,,

Nova Sco 1994,BAT,35,2,100,253.74,-40.5,0,0,0,0,100000.0,Planning Exercise,30,0,,

4U 0115+63,BAT,18,2,100,169.63,63.74,0,0,0,0,100000.0,Planning Exercise,80,0,,

2.2
Output File Descriptions
2.2.1
Target Database file

The Target Database files saved by TAKO have the same format as input file.
2.2.2.
Preplanned Science Timeline (PPST)

This section describes the format of the PPST file.  The PPST file contains the schedule produced by TAKO. It is input to the MPS where the PPT events are used to add PPT request commands to an ATS load.

Filename Convention
PPST_yyyydddhhmm_yyyydddhhmm_vv.txt

yyyydddhhmm is a time stamp where yyyy is a 4-digit year, ddd is the 3-day day of year and hh is hours and mm is minutes.  The time stamps indicate the beginning and end times of the TAKO window of interest for which the PPST was generated. All events in the timeline occur within this range.

vv is a version number, initially 00.  It is used to distinguish different PPST files created for the same time range.  The highest number is the most recent version.

Example: PPST 20030071200_20030101200_00.txt

File Format

A  PPST record is composed of  4 or 17 columns (fields) which are defined in Table 2.2.2.   Columns 5 through 15 are used to create the PPT request command.  These fields are defined by the FOPPTREQUEST spacecraft command which is documented in the flight software documents.

Table 2.2.2. PPST Fields

	Column
	Description
	Format

	1
	Time Of Event
	YYYY-DOY-HH:MM:SS

	2
	Event Type
	Text: PPT, mnv, saa, ….

	3
	Begin/End of Event
	Text: Begin or End

	4
	Target Name
	Text: Target name or Global

	5
	Target ID
	Unsigned Integer (24 bits)

	6
	Observation Segment Number
	Unsigned Integer (8 bits)

	7
	Observation Number
	Unsigned Integer (32bits)

	8
	RA
	Floating point (64bits) 

	9
	DEC
	Floating point (64 bits)

	10
	Roll
	Floating point (32 bits)

	11
	BAT Mode
	Unsigned integer (16 bits)

	12
	XRT Mode
	Unsigned integer (16 bits)

	13
	UVOT Mode
	Unsigned integer (16 bits)

	14
	Merit Value
	Floating point (32 bit)

	15
	Requested Observation Seconds
	Unsigned Integer (32 bits)

	16
	Comment
	Text

	17
	Target DB Name
	Filename of the Target DB used to create this record


Each record in the PPST file refers to a TAKO event.  The PPST file always contains, for each scheduled snapshot, events with Event Type of PPT; one for the start of the PPT and one for the end.  Also for each snapshot, there will be two events for each slew maneuver  (Event Type = mnv).  Optionally, the PPST may contain other events such as SAA entry and exit time or target occultation event.  The output of these optional events is controlled by its associated constraint definition in the TAKO Target Database (Target DB). 
2.2.3.
Master PPST

The Master PPST contains a summary of the current and previous approved PPST files. The amount of time covered in the Master PPST is controlled by keywords in the TAKO configuration file.

Filename Convention
The filename is also set in the configuration file.  These values must correspond with the values expected by the Timeline Monitor.

File Format

The master preplanned science timeline file format is described in the SDC-MOC ICD in the Master PPST section.  All PPST files have the same format.  The only difference between these files is the time period covered by the data.
2.2.4.
Archived Master PPST

The archived master PPST is a copy of the an older Master PPST and it will have the same time range as the Master PPST and the file name is based on the Master PPST filename. The filename contains a timestamp for the start and end of the data since the Master PPST is archived each time a PPST is approved.

Filename Convention
MasterPPST_yyyyddd_yyyyddd.txt

where yyyy is the 4-digit year 

ddd is 3-digit day of the year (001 – 366)

Example: MasterPPST_2002114_2002146.txt

File Format

The archived master preplanned science timeline file format is described in the SDC-MOC ICD in the Master PPST section.  All PPST files have the same format.  The only difference between these files is the time period covered by the data.
2.2.5.
Database report file

The Database Report  file contains a human-readable report of the contents of the current database file.  It also computes some statistics regarding the schedule.  The statistics include:

1. a list of the observation segments that are over 2 days long

2. total schedule efficiency

3. the percentage of the schedule taken by each target type.
Filename Convention
The report is stored in the TAKO data directory.  The report file name format is: 

<base-target-db-name>_rpt.txt
Example: targ_20023510000_20023540000_00_DB_rpt.txt

File Format

TBS
2.2.6.
Target CSV File

The exported target CSV file has the same format as the input Target CSV file. 
2.2.7.
Log File

The TAKO log file contains messages from the info box plus other messages that record the processing history. A new, time-stamped file is created in the current directory for each TAKO session (A session starts each time Tako is started and ends when the user quits TAKO.).  

Filename Convention

The log file is created in the current working directory. (The directory you are in when you started TAKO.) The log filename format is tako_YYYY_DDD_HHMMSS.log.

File Format

The file contains a copy of the messages written to the Info box plus other messages generated within TAKO for troubleshooting. The messages are timestamped.

3.
Running TAKO
The SOT user account must be setup according to the installation instructions in Appendix A.  As a user, you only need to know about  the TAKO data directory and the command to start TAKO.  The TAKO data directory exists under the SOT user's home directory.  An environment variable, TAKODATA, is set to that directory for your convenience.  Also an alias command, runtako, has been defined that starts TAKO using the installed TAKO configuration file. 

For Swift operations, TAKO must always be run against the same TAKO data directory.  This maintains scheduling continuity. Also, TAKO is a single user system, so only one person at a time can use TAKO.

The easiest way to start TAKO is:

% runtako
The first time TAKO is run, the user must load a target database.  A sample database is provided with the software installation. You may modify this database or start with an empty database.  In subsequent runs of TAKO, the target database used in the previous session will be loaded automatically.  
TAKO can also be told to load a particular database on startup by using the load option.  
Example:

% runtako load=$TAKODATA/targ_20032330000_20032360000_DB.tcl

3.1. 
Typical Scheduling Process
This list shows steps in the typical daily scheduling process:
1. Start Tako and load the current target database.

2. Set the scheduling period and choose a new ephemeris if necessary.
3. Update observation segment definitions (add, change, archive).
4. Schedule the observations.
5. Evaluate the schedule.
6. Save the schedule (in the target database).
7. Create the PPST.
8. Approve the PPST (transfer files to the MOC subnet).
The following sections explain how to use Tako to do each of the steps.
3.1.1.
Start Tako

Start Tako by running this command:
% runtako
Unless this is the first time you have run TAKO,  the database whose name is saved in the .takoSession file will be loaded automatically.  If you don't want to work with the target database from the previous session, you can choose another file.  Select File=>Load=>Load Target DB from the menu bar.
.
TAKO will load the information from the database, read the ephemeris file, and compute the constraint data. This may take a few minutes. Then it plots schedule timelines in its main panel, displays the observation list, and a message log window (Info box).
The currently scheduled snapshots will be plotted on the "mainevents" timeline. Global constraints, such as SAA and Slew, will also be plotted.

3.1.2.
Set the scheduling period

Start the target database editor by selecting File=>Edit=>Edit TargetDB from the menu bar.  The editor comes up in the "Context" panel.  The other panels are "Observations" and "Constraints".  Enter the date for the new scheduling period.  Press the TAB key and the window start entry will be updated.  Adjust the duration and window of interest start time if necessary.  Click the Select File button to choose the most up-to-date ephemeris.  The files are listed in a selection dialog.  The name of  the file contains the range of times for which the file contains data. Select the ephemeris file that includes the start and end of the scheduling period and press the Enter key.
Click the Change button when you are done updating the context. The lower portion of the edit panel will be updated.  If you don't press Change button, the new entries will not be applied.
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Figure 3.1.2. Context edit panel
3.1.3.
Update the observation segment definitions

Select Observations=>Edit Observations from the menu bar of the Target Database Editor to switch to the observation editor. The observation editor allows you to add, modify, or remove observation segment definitions in the target database. The observation segment definition editor panel shown in Figure 3.1.3 is made up of two sections:  the edit pane and the definition list.  New definitions may be added by typing in the edit pane fields, or by importing the definitions from a CSV file.  The format of a Target CSV File is given in the input file definition section.  
Certain fields of an existing observation segment definition may be modified.  To modify the observation, select the observation from the definition list.  You may modify the fields in the Scheduling Rules area or the target name, type, or comment fields.   If the observation is scheduled, information is displayed in the Schedule Summary box. The list of snapshots can be viewed by selecting the View Snapshot List button. The sched_status field indicates whether the observation is scheduled or not.  The values of the sched_status field are similar to the values of the "s" field in the Target Viewer.  The status codes are described in Table 4.2.3. 
Fill-in Targets

Fill-in targets are just a set of observations that are guaranteed to have at least one visible (within constraints) at all times. These observations are delivered in a CSV file so they can be imported into an existing database.   The priority is lower than any of the primary observations so that the fill-in targets will be scheduled only during gaps in the primary observations.  The target type is set to "Fill-in".  Thus fill-in targets can be unscheduled as a group if necessary.  
The observation definitions of the fill-in targets will have to be maintained by the user.  Periodically, the segment numbers of the fill-in targets need to be updated to accommodate science data processing needs (Two-calendar day observation maximum.) 
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Figure 3.1.3. Edit Observations panel 
The fields are validated when you press TAB or Enter, and when you click on the Add or Change buttons. (The fields are not validated if you use the mouse to select a new field.)   

The Restore button restores all of the edit fields to the values they had originally.  It is equivalent to selecting the entry again.

The Clear button sets all of the edit fields to default values.

The Delete button removes an observation segment definition from the database. It is enabled only for observations that have not been scheduled.  There is no "undelete" feature.  So don't delete an observation unless you mean it.
The Archive button also removes an observation segment definition from the database. It is enabled only for observations that are scheduled.  You may wish to archive observations that have been completely observed, or can no longer be scheduled due to constraints.  If the duration in the Schedule Rules area and the duration in the Schedule Summary area are equal (or close enough), then this target is completely scheduled. If the stop time of the scheduled snapshot in the past, then it is safe to archive the observation.  Archiving old observation cuts down on the clutter in the observation list.  Keeping the observation list short also slightly reduces the time it takes to autoschedule because the autoscheduler does not have to examine as many observations to determine what can be scheduled.

Scheduled observations are archived rather than merely deleted because we need to keep a list of assigned observation numbers.  This list is used, in conjunction with the observations in the current database, to ensure that observation numbers are not reused and that target IDs are not assigned to different locations.  There is no "unarchive" feature.

3.1.3.1. When to Add

You must use Add when you change any fields that are used as parameters to the FOPPTREQUEST command:

· Target id

· Segment number

· Figure of merit (FoM)
· Right Ascension (RA)
· Declination

· Roll

· BAT instrument mode

· XRT instrument mode

· UVOT instrument mode

Most commonly, you will create a new definition based on an existing definition when a new roll angle is needed, when a new initial instrument mode is desired, when the observation segment has been completely scheduled, or when the two-day limit on an observation segment has occurred.  After you make the necessary changes in the parameters, you must change the segment number to the next available value (usually by adding 1).
3.1.3.2 When to Change

The Change button is used for parameters that do not affect the FOPPTREQUEST command parameters. The fields in the Scheduling Rules  section can be changed for an existing segment as well as the target name, target type, and comment fields.  
Most commonly, you will want to change the duration in order to schedule additional snapshot for the observation.   Also, you may change the priority of an observation segment so that it is scheduled when you want it.

3.1.3.3 Importing a Target CSV file

The import function enables targets to be imported from other planning applications or from a spreadsheet.  Format is in ?
File => Import Targets (.csv) shows a file selection dialog that lists all of the files with csv as the extension.  The default data directory is shown.  You can change the directory to the location of your CSV file.  The lines in the file are read, validated, and added to the observation list. Validation messages are written to the log screen. If a line is invalid, it is ignored and processing continues with the next line.  If the target id and segment in a line is the same as an existing or archived observation segment, it is treated as an invalid line.

3.1.3.4 Saving changes

After making changes to the target database, you may save the information.  If the target database state is Working, then you may replace the current file.  If the state is Alternate or Approved, you must enter a new file name.  The recommended format is targ_YYYYDDDHHMM_YYYYDDDHHMM_VV_DB.tcl where the times are the start and end of the schedule period and VV is a version number starting with 00.   The filename must end in "DB.tcl" or else the selection dialog will not display it. Use the Save As selection in the main File menu because it automatically generates a file name in the recommended format.
NOTE: Saving a target database can be more complicated than just writing the new records to a file.  Changes during the editing session may affect the validity of the current schedule. The change in ephemeris or constraint definitions may cause currently scheduled snapshots to no longer be in a Goodtime period.  A change in the observation duration or priority may eliminate the need to some of the scheduled snapshots.  Since the definitions must be consistent with the schedule, the snapshots in the window of interest are deleted before the database is saved when any changes are made that affects scheduling.  

3.1.3.5 Exiting from the editor

After saving the modified target database, select File=>Close to exit from the editor.  If target database was not saved during the session and if the changes affect the validity of the current schedule, the snapshots in the window of interest will be deleted when you exit.  
3.1.4.
Schedule the observations

There are many ways to use the observation scheduler:

1.  Place the targets by hand using the timeline.  
2.  Automatically schedule from the entire target list

3.  Automatically schedule from a subset of the target list 

4.  Combination of the above
A subset of the observation list can be scheduled either by putting the subset into the pool, or by using the Target Selection function.  Even though the Autoscheduler panel allows you to choose "All targets", this means all observations currently displayed in the Target Viewer.  The Target Selection function can be used to reduce the number of observations displayed.

Unlike the legacy TAKO, the Swift observation scheduler can interleave snapshots from several targets.  So when one target can't be observed, a snapshot from another target can begin. Also, the Swift observation scheduler can schedule partial observations.   The observation may start in the current scheduling period and have some of its snapshots in this period, but may not be completed due to constraints and the presence other scheduled snapshots.  When the scheduling period is advanced, the remaining time can be scheduled for the partially scheduled targets.
NOTE: "Complete chains" has not been implemented.
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Figure 3.1.4. Autoscheduler Panel
Click Autoschedule to initiate the autoscheduler function. The autoscheduler sorts the observations by priority to create an ordered target list. Then it removes the observations that do not have any "goodtime" during the window of interest to create a visible target list.  These targets are visible in the context that they can be observed without violating constraints. For each observation in the visible target list, the autoschedule attempts to schedule the observation.  It starts at the window start time and bumps the observation start time until scheduling succeeds or the end of the window is reached.  The autoscheduler places as many snapshots on the timeline as it can.  Thus, a high priority observation will have all of its snapshots scheduled before a lower priority observation is scheduled.  The lower priority observation is scheduled in the gaps between the high priority observation's snapshots. 
3.1.5.
Evaluate the schedule

File => Write Database Report menu option creates a file containing a human readable report of the contents of the current database file.   It also computes some statistics regarding the schedule.  The statistics are displayed in the info box as well. This report is described in the Output file section above.
3.1.6.
Save the schedule (in the target database)

It is good practice to save your work periodically.  Use File=>Save to save to the current target database file name.  Use File=>Save As to save with a different file name.  TAKO will not let you Save to an Alternate or Approved file.  You will normally start the scheduling session with the most recent approved database, make the necessary changes, then save the file, using Save As, as a new working database.
3.1.7.
Create the PPST

Once you are happy with your schedule, you need to write it as a preplanned science timeline (PPST) file.  NOTE:  The target database must be saved before doing this. Use the File => Timeline => Write preplanned science timeline (PPST) menu option. It may take a minute to write the time.  Wait until the completion message is written in the info log window.  The target database now is in the Alternate state.  You may no longer save to this particular file.   
If you decide you don't like this PPST, you may delete it using the File => Timeline => Delete PPST menu option.  This deletes the PPST file and resets the target database to the Working state.

3.1.8.
Approve the PPST

When you are ready to commit this timeline to be uplink to the spacecraft, use the File => Timeline => Approve PPST menu option.  TAKO does four things:
1. Set the Target Database file to the Approved state.

2. Creates the Archive Master PPST from the current Master PPST

3. Updates the Master PPST with the new timeline.

4. Transfers the Target Database, the PPST file, and the two Master PPST files to the MOC subnet.

4.
TAKO User Interface
4.1.
 TAKO main display

4.1.1.
Main Menu
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The pull-down menus on TAKO's main display can be changed to tear-off menus.  You can make them stay open by clicking on the dotted line at the top of the list.  The menu is then displayed in its own window.  When you close the window, the menu reverts to a pull-down menu.  The pull-down feature is handy to use with the Target menu.  It makes it easier to put observations in the scheduling pool when you keep the menu open.

4.1.1.1. 
File
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Figure 4.1.1.1. The File menu as a pull-down and as a tear-off.

4.1.1.1.1
 Load
The Load menu has a cascade menu with two choices:

· Load Target DB

· Load Ephemeris

Load Target DB is used to select and load a Target DB.  This allows you to work on an alternate schedule by reloading the last approved Target Database file.

Load Ephemeris is used to select a new ephemeris file.  A new ephemeris file is usually selected using the Target Database Editor.  This menu is a short-cut most often used after advancing the schedule (see the Schedule menu).  Loading a new ephemeris will unschedule any currently scheduled snapshots in the window of interest.  It does that because the new ephemeris may change the constraint values and cause the currently schedule snapshots to occur when constraints are violated.
4.1.1.1.2
 Edit

The Edit menu has one option: Edit Target DB.

This brings up the Target Database Editor panel.  Operation of the Target Database Editor is described in another section.
4.1.1.1.3 
Save

The Save menu has two options:

· Save Target DB

· Save Colors

The Save Target DB menu option is used to save the target database to the current filename.  If the target database is Alternate or Approved, an error dialog will be displayed advising you to use the Save As menu.  You are only allowed to save changes to a Working database. 

The Save Colors menu option is used to save the currently select colors in the TAKO user preferences file (.takorc).  The Change Colors feature is entered when the middle mouse button is clicked in one of the display windows.  

4.1.1.1.4 
Save As

The Save As menu has only one option: Save Target DB As.

A file selection dialog is presented.  TAKO suggests a valid target database name.  There is usually no reason to change the directory or the suggested filename. Click Save to accept the name and save the database to the new file name. The suggested filename has the format: targ_YYYYDDDHHMM_YYYYDDDHHMM_VV_DB.tcl.  Click Cancel to exit the dialog without saving the database.

TAKO creates the target database filename based on the schedule start and stop times.  If any database files with the same start and stop times already exist, then TAKO bumps the version number of the highest version to create a unique filename.  

4.1.1.1.5
Output

The Output menu is for miscellaneous output options:

· Write Database Report

· Export Database (CSV)

· Write Graphs

The Write Database Report menu option creates the Database Report file described in the Output File Description section.

The Export Database (CSV) menu option creates a comma-separated file containing the observation definitions in the currently loaded target database.  The format is described in the Output File Description section.

The Write Graphs menu option saves the current timeline window as a Postscript file.  This file can be printed to a postscript printer with the UNIX lp command.
4.1.1.1.6 
Timeline
The Timeline menu deals with the preplanned science timeline.  The options are:

· Write Preplanned Science Timeline (PPST)

· Delete PPST

· Approve PPST

· Retransfer PPST

The Write Preplanned Science Timeline (PPST) option creates the PPST file based on the currently scheduled snapshots and events.  The target database must be saved before choosing this option.  You'll get an error dialog if it is not. You only want to write the PPST once you are satisfied with your schedule.  It may take a minute to write the timeline.  The PPST file is saved in the TAKO data directory. Wait until the completion message is written in the info box (log window) before doing anything else.  The target database is now put in the Alternate state.  You may no longer save to this particular target database file.  

The Delete PPST menu option deletes the PPST file and resets the target database to the Working state. Use this when you decide you don't like this PPST and want to continue tweaking the schedule.  This option is only available when the database is in the Alternate state.

The Approve PPST menu option transfers the PPST (and other files) to the MOC Closed subnet.  Use Approve PPST only when you want to commit this schedule to be uplinked to the spacecraft.  TAKO does four things when a PPST is approved:

1. Sets the Target Database file to the Approved state.

2. Creates the Archive Master PPST from the current Master PPST

3. Updates the Master PPST with the new timeline.

4. Transfers the Target Database, the PPST file, and the two Master PPST files to the MOC subnet.  The only error you should get is a file transfer failure.   This could happen if the workstation you are transferring to goes down or there is a problem in the network connection.  See the troubleshooting section for more details.  Once the problem is solved, use the Retransfer PPST option to attempt the file transfer again. (Move to troubleshooting section: The transfer is done in a script called TransferToMOC.pl. The transfer is done by copying these files to the transfer directory. The files are combined into a "tar" file prior to transfer, so you may see a .tar file remaining in the transfer directory if the transfer files.)  
The Retransfer PPST menu option attempts the file transfer again.  You need to use this only if you get a message stating that the file transfer to the MOC failed during the Approve PPST function.  Also, you need to have remedied the problem that caused the failure.  This only attempts the file transfer.  It does not update the Master PPST again.
4.1.1.2. Plotting

The Plotting menu allows the user to change the characteristics of the timelines in the POW box. These options are typically not needed  for routine scheduling.  Plotting single curve choices may be useful for getting an overview of the "goodtimes" or of the roll angle constraint of several targets at once in order to analyze why a schedule is turning out the way it is.
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The Plot Timeline Curve Set menu option replots the timeline.  It mainly used to restore the timeline plots after showing the "single curves".  It can also be used to replot the timeline if it "looks funny" after editing the database, especially if a constraint definition is added.  
The Single Curve Choices menu option allows the user to select an event curve that you want to see plotted for several targets.  For example, you may plot the "goodtime" curve for all of the observations of the same target.  
The Plot Single Curve Set menu option redraws the timeline window so that it only shows the selected "single curves".   This is not typically something you'd want to do for all targets in the observation list at once.  Use the Target Selection entry to narrow the list, first. (See Section 4.1.3.3.)
The Align Graphs menu option resets any timeline you may have moved back to its original position. 

The Lock Graphs? check box controls whether the timelines can be moved horizontally or not.  Check the box to prevent the user from moving the timelines horizontally.  Unchecked, the user can move the timelines horizontally, but that is not recommended.
The MJD Tickmarks check box controls whether or not the timescale on the plot X-axis is shown as Modified Julian Date (MJD) or as a calendar date. This is typically unchecked so that the time is shown in the same format that the rest of the MOC uses.
4.1.1.3. Target
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The Null Target menu option deselects the currently selected observation.  
The options involving the "pool" are fairly self-explanatory.  The "pool" is a subset of the observation list.  The Autoscheduler can be told to schedule only the "pool" observations. 

Observations can be added to the pool individually by selecting the observation from the Target Viewer, then clicking the Cast current target into pool menu option.  The word "pool" is added to the status column of the observation.  Several observations can be added to the pool at the same time. First display a subset of the observations using the Target Selection entry.  Then click on the Cast all listed targets into pool menu option All the listed observations will have "pool" added to the status column.  

To remove the observations from the "pool", use the Pull current target from the pool menu option or the Pull all listed targets from pool menu option. The status column will be update to show that the observation is no longer in the "pool". 
NOTE:  Currently,  lock and  ignore do nothing useful, so they are disabled. Also, 
Load Chain/Monitoring is not currently implemented for Swift.  See the TAKO Issues section.
4.1.1.4. Schedule
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Unschedule Targets

Unschedule Targets offers several options for removing scheduled snapshots from the schedule. The snapshots are unscheduled only during the current window of interest.  Therefore, any snapshots scheduled before the start of the window of interest or after the end of the scheduling period will not be removed.  When a snapshot it unscheduled, the resources used by the snapshot are restored. You will see the slew resource is replenished.   
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Current – unschedules the snapshots for only the currently selected observation

All – unschedules the snapshots for all observations

Autoscheduled – unschedules the snapshots for only the observations that were scheduled using the autoscheduler.  Observations scheduled by the user clicking on the timeline will remain scheduled.

The remaining options are target types.  You may unschedule observation based on its type.  Selecting Fill-in will unschedule all of the observations with the Fill-in type.

The set of target types are defined in the TAKO configuration file.  The target type is assigned when the observation definition is created in the Target Database Editor.
AutoSchedule Control Panel

The AutoSchedule Control Panel menu option is used to initiate the autoscheduler. Clicking on the AutoSchedule Control Panel menu option displays the Auto-Schedule Parameters window.  These parameters allow the autoscheduler behavior to be customized.  Figure 4.1.1.4-1 shows the recommended settings for the typical Swift scheduling scenario.
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Figure 4.1.1.4-1.  Autoschedule Control Panel
Observation Set allows the user to indicate which set of observations to input to the autoscheduler.
Check All targets to use all of the observations that are currently displayed in the Target Viewer list.  You may use the Target Selection entry to display a subset of the observation list.  Only this subset will be input to the autoscheduler.
Check 'Pool' targets only to use the observations marked as pool targets.  These targets will have "pool" in the "s" column in the Target Viewer list. Observations are marked as pool targets using the Cast current target into pool menu option under the Target menu.
Start scheduling from… allows the user to indicate the time after which new snapshots are to be scheduled.
Check Window start time and new snapshots will be scheduled starting at the beginning of the window of interest.  This selection is recommended for Swift.
Check Last-clicked time from timeline and new snapshots will be scheduled starting at the marker.
Check Last scheduled item and new snapshots will be scheduled after the last scheduled snapshot.
End scheduling from… allows the user to indicate the time after which no new snapshots are to be scheduled.  For Swift, since the end of the window of interest and the end of the schedule period are the same, this option is not useful.
Window stop time

Schedule stop time

First Priority Sort Field  allows the user to indicate the order in which observations will be scheduled based on observation segment definition field values.  All fields are available for selection, but "priority" is recommended for Swift. If none is selected then the observations are not scheduled in any particular order.
The sort order choices are:
Lowest/smallest/earliest – Smaller value first, ascending order
Highest/largest/latest – Larger value first, descending order (recommended for Swift)
Second Priority Sort Field allows the user to indicate a secondary sort order for observations after they are sorted by the first priority field. All observation definition fields are available, but "none" is recommended for Swift.  There may be a situation where duration  or FoM value may be a useful secondary sort criterion.
The sort order choices are:
Lowest/smallest/earliest – Smaller value first, ascending order
Highest/largest/latest – Larger value first, descending order 

After the autoscheduler parameters are set, click the Autoschedule button to initiate the autoscheduler.  When the estimated time it may take to run the autoscheduler is greater than 15 minutes, a dialog box is displayed to prompt you to continue running the autoscheduler or to cancel. 

When the autoscheduler runs, it displays another dialog box to show progress and to allow you to stop the autoscheduler (Figure 4.1.1.4-1).
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Figure 4.1.1.4-2.  Scheduling Status Dialog
Number of targets selected is the number of targets the autoscheduler found that were eligible to be scheduled.  These targets are taken from the observations currently displayed in the Target Viewer.  Observations that are completely scheduled are not included in the count.  

Visible targets is the number of targets have "goodtime" periods in the window of interest. This value is incremented as the autoscheduler examines each target in the selected list.  If a target does not have any "goodtime", then it is removed from the list so the autoscheduler doesn't waste time trying to search for a place to schedule it.
Targets scheduled so far is incremented for each scheduled observation.

Abort is used to prematurely exit from the autoscheduler. The observations scheduled so far will remain scheduled.

Advance Schedule

The Advance Schedule menu option updates the schedule start and stop times so that the schedule start time is midnight of the current day and the window of interest start time is adjusted to have the current window duration.  The schedule stop time is adjusted to retain the current schedule period.   This is a short cut to be used when the only change to the database is to advance to time window.  TAKO reloads the current ephemeris using the new time range, regenerates the constraint curves, and replots the timelines. Currently, scheduled snapshots will not be affected.  The "s" field in the Target Viewer may be updated to reflect the current status. For example, an observation that was "s p" may became "t p" if the starting snapshot is before the new window of interest.
After advancing the schedule, you should save the target database using Save As.  Now you can schedule to new time period as necessary. 

4.1.1.5.
Canvas

The Canvas menu allows the user to configure the placement of the display components on the screen, and control which timelines are sensitive to the scheduling mouse button.  These options are not likely to be needed for routine scheduling.
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The enable POW editbox checkbox is probably not useful.
Select the  pop Targets checkbox to remove the Target Viewer from the main display and put it in a separate window.  The nice thing about having the Target Viewer in a separate window is that you can resize the window to show more observations at a time than the 10 or so you see when it's part of the main display.  It also allows the POW box to expand to show all of the timelines without needing to scroll.  Deselect the checkbox to put the Target Viewer back on the main display. 

Select the pop Info box checkbox to remove the Info box from the main display and put it in a separate window. The window can be resized to show more lines at one time.  Deselect the checkbox to put the Info box back on the main display. 

Select the pop POW checkbox to remove the POW box from the main display and put it in a separate window.  Deselect the checkbox to put the POW box back on the main display. 
The Allow Scheduling on… menu option allows the user to indicate which timelines are enabled for scheduling.  This is probably not useful for Swift.
4.1.1.6. 
Help

Not implemented
4.1.2.
Timeline window (POW box)
The timeline window provides a graphical representation of the schedule.   It consists of three functional parts:  The timeline area, the marker time display, and the Pan and Zoom buttons.

1.2.1. Timeline area

The timeline area plots are implemented with a package called POW, hence the name POW box.  

The first three timelines are permanent.  They are defined by the application.

· The "mainevents" timeline shows the scheduled snapshots.  Each snapshot is represented by a solid blue box.  The left edge of the box is on the start time of the snapshot and the right edge is at the stop time.  The height of the box indicate the observation's priority (tall boxes are high priority targets.) The starting snapshot is labeled with the target name.  One indication of a completely filled schedule is that there are no visible gaps in between the boxes. (However, observations with a priority lower than 5 might appear so short as to not be distinguishable from a gap.)  This timeline is also used for input.  The user can select a target by clicking a blue box with the right mouse button.  The user can schedule a selected target by clicking the left mouse button on an empty area of the timeline.
· The "goodtime" timeline shows, for the selected observation, the blocks of time during which no constraints are violated.  These are the good times for scheduling snapshots.

· The "slew" timeline shows the value of the slew angle resource. When the value is near zero, no observations can be scheduled.  So if a gap in "mainevents" coincides with a low "slew" value, then no observation can be scheduled in that gap because any slew to an available target would cause the slew angle limit to be violated.  
The other timelines are controlled by the constraint definitions in the target database.  As delivered, the constraints are:

· The "saa" timeline is a global constraint since it does not depend upon which target is selected.  It does not affect scheduling, but it is used to compute the requested observation seconds  (REQOBSSECS) field for the PPST output file.

· The "roll" timeline shows for the selected target, any roll angle constraint violations. The times when the constraints is in violation are shown as red boxes, otherwise the line is empty.  Empty is good.

· The "ramlimit", "sunlimit", "moonlimit", and "occult" timelines show violations of  the ram angle, sum angle, moon angle, and earth occultation constraints. (See Requirements)

· The "orbit" timeline shows a blip at the start of each orbit (ascending node time).  This is not used for automatic scheduling, but may be a useful reference.  

· Other timelines will be displayed if additional constraints, such as the time critical (TC) constraints are defined by the user.
· Other timelines represent data used in generating constraints, such as moonangle.  They are for information only and their plots are purple.  
The display order of the timelines is controlled by the Display parameter in the constraint definition record.  Also reduce the number of timelines plotted, any of these timelines can be hidden by setting the Display parameter to 0.  See the database description for more details.

One nice feature of POW that the user can compare two or three timelines by dragging the timeline up or down the Y axis to overlay another timeline.

1.2.2. Marker time display

The marker time displays the time that corresponds to the marker ( + cursor) position on the timeline.  The time is displayed as calendar date and time with the 3-digit day of year.  This time format is consistent with the format used in the rest of the MOC. In this release, the MJD is also displayed.

1.2.3. Timeline Zoom and Pan

When a scheduling period is long, the timeline plot may not give the resolution necessary to see where to click or how big a gap really is.  The zoom feature gives the user a close-up view of a section of the timeline.
|Pan Left | Zoom In |Zoom Out |Pan Right|  buttons have a slider bar below them.  The range of the plotted area is shown when you Zoom.
The init file has a variable Optional_Zoom_Type when set to 1, you can only zoom in or out by 1 magnification.  When set to 0, zooming is effectively unlimited. 

NOTE: Zoom still occasionally causes TAKO to crash so you may want to save the schedule before zooming.

Zoom In will magnify the area around the marker.  If the marker is not set, it magnifies around the center of the window of interest.

Zoom Out expands the visible time range.  It stops zooming out when the original schedule start and stop times are reached.

Pan Left and Pan Right are effective only when zoomed in on the timeline.  It actually works reasonably well. You can scroll earlier and later in the schedule while zoomed in. The time labels on the slider are updated to show the current plot range.
4.1.3.
Target Viewer window

4.1.3.1 Target Viewer List

The Target Viewer is a multi-column list of the observation segment definitions along with any schedule information.  The first column is the unique observation number, the second column is a status field, and the remaining columns contain database fields.   The rows in the list can be sorted by clicking the left mouse button on the column heading.   Clicking again on the heading toggle the sort direction between ascending and descending.   The width of the columns can be adjusted by clicking on the seam between the headings and dragging.
Selecting a Target
A target can be selected in two ways.  One way is to click the left mouse button on an entry in the Target Viewer list.  Another way is to click the right mouse button over a scheduled snapshot on the "mainevents" timeline.  This will highlight the corresponding entry in the Target Viewer list.

4.1.3.2 Nudge

The Nudge feature allows the user to make small changes in the observation start time.  It is available when a scheduled observation is selected.  The buttons are self-explanatory.  The scale is set to that the left and right edges represent the begin time and end time of the "goodtime" that brackets the start time.  

4.1.3.3 Target Selection

The Target Selection area is used to display a subset of the observation list in the Target Viewer list.  Determine a string that characterizes the desired subset, type the string in the text entry box and press return.  (Note: This is a strict string match, not a regular expression.) TAKO displays only the entries that contain the string in any field.   Click on the Reset Selection button to show all the entries again.  This feature provides any easy way to display observation of a certain type, or all observations of a certain target ID. 
4.1.4.
Info box window
Status messages are displayed in the Info box.

The messages are color coded:

· Black text is for routine informational messages. 
· Blue text is for warning messages – something couldn't be done, but the user can recover

· Red text is for error messages – Tcl errors, and for hard errors such as not being able to open a file.

The messages written to the Info box are also written to the TAKO log file.
4.2.
 Target Database Editor
The Target Database Editor is used to change the scheduling window, the observation segment definition list, and the constraint definitions.  The menu item for Resources in not implemented. 
4.2.1.
Menus
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4.2.1.1. File menu
Load Target DB  - select and load a target database file.  This is the same as Load => Target DB in the main file menu.  This menu is typically not used.

Import Targets – select and load observation segment observations from a comma-separated-value (CSV) format file.  See Input File Definitions section and Update Observation List section
Update Schedule – updates the schedule based on current changes to the database.  This may result in all the snapshots of the current schedule being deleted.
Save Target DB – Update the schedule and save the edited database values.  Performs the function of Update Schedule, then displays a file selection dialog.  Enter a file name and click on Save. 
Export Targets – Write the observation definitions to a CSV-formatted file.  This file can be imported by a spreadsheet or other planning tool.  This does not export the schedule or the constraint records.  
Database Report – This is the same as the Output => Write Database Report function on the main menu.  It is repeated here for convenience.
Close – exit from the editor.  Update the schedule as in the Update Schedule function. Then copies the database information to the TAKO scheduler data structures and closes the editor window.   Changes to the target database do not have to be saved in the editor.
They can be saved from the main menu.

4.2.1.2. Context

Has one menu item: Edit Context. This menu option  brings up the context editor panel which is described in Section 4.2.2.
4.2.1.3. Observations

Has one menu item: Edit Observations.  This menu option  brings up the observation editor panel which is described in Section 4.2.3.

4.2.1.4. Constraints

Has one menu item: Edit Constraints.  This menu option  brings up the constraint editor panel which is described in Section 4.2.4.

4.2.2.
Edit Context

The Edit Context panel allows the user to set the scheduling period, window of interest, and ephemeris file to be used for scheduling.   In the lower portion of the window, it  displays all of the database context including whether or not the PPST has been generated and the schedule state.

Enter the date for the new scheduling period.  Press the TAB key and the window start entry will be updated.  Adjust the duration and window of interest start time if necessary.  Click the Select File button to choose the most up-to-date ephemeris.  The files are listed in a selection dialog.  The name of  the file contains the range of times for which the file contains data. Select the ephemeris file that includes the start and end of the scheduling period and press the Enter key.

Click the Change button when you are done updating the context. The lower portion of the edit panel will be updated.  If you don't press Change button, the new entries will not be applied.
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Figure 4.2.2. Context edit panel

4.2.3.
Edit Observations 
The observation editor allows you to add, modify, or remove observation segment definitions in the target database. The observation segment definition editor panel shown in Figure 4.2.3 is made up of two sections:  the edit pane and the definition list.  
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Figure 4.2.3. Edit Observations panel
The edit pane contains an entry for each field in the observation record and in the scheduling rules record.  It also show the scheduling status of an observation. Certain fields of an existing observation segment definition may be modified.  To modify the observation, select the observation from the definition list.  You may modify the fields in the Scheduling Rules area or the target name, type, or comment fields.   If the observation is scheduled, information is displayed in the Schedule Summary box. The list of snapshots can be viewed by selecting the View Snapshot List button. 
The fields are validated when you press TAB or Enter, and when you click on the Add or Change buttons. (The fields are not validated if you use the mouse to select a new field.)   

You must use Add when you change any fields that are used as parameters to the FOPPTREQUEST command:

· Target id

· Segment number

· Figure of merit (FoM)

· Right Ascension (RA)

· Declination

· Roll

· BAT instrument mode

· XRT instrument mode

· UVOT instrument mode

Most commonly, you will create a new definition based on an existing definition when a new roll angle is needed, when a new initial instrument mode is desired, when the observation segment has been completely scheduled, or when the two-day limit on an observation segment has occurred.  After you make the necessary changes in the parameters, you must change the segment number to the next available value (usually by adding 1).
The Change button is used for parameters that do not affect the FOPPTREQUEST command parameters. The fields in the Scheduling Rules  section can be changed for an existing segment as well as the target name, target type, and comment fields.  Most commonly, you will want to change the duration in order to schedule additional snapshot for the observation.   Also, you may change the priority of an observation segment so that it is scheduled when you want it.

The Restore button restores all of the edit fields to the values they had originally.  It is equivalent to selecting the entry again.

The Clear button sets all of the edit fields to default values.

The Delete button removes an observation segment definition from the database. It is enabled only for observations that have not been scheduled.  There is no "undelete" feature.  So don't delete an observation unless you mean it.

The Archive button also removes an observation segment definition from the database. It is enabled only for observations that are scheduled.  You may wish to archive observations that have been completely observed, or can no longer be scheduled due to constraints.  If the duration in the Schedule Rules area and the duration in the Schedule Summary area are equal (or close enough), then this target is completely scheduled. If the stop time of the scheduled snapshot in the past, then it is safe to archive the observation.  Archiving old observation cuts down on the clutter in the observation list.  Keeping the observation list short also slightly reduces the time it takes to autoschedule because the autoscheduler does not have to examine as many observations to determine what can be scheduled.

Scheduled observations are archived rather than merely deleted because we need to keep a list of assigned observation numbers.  This list is used, in conjunction with the observations in the current database, to ensure that observation numbers are not reused and that target IDs are not assigned to different locations.  There is no "unarchive" feature.

The definition list is a tabular list of the observation records in the database.  The sched_status field indicates whether the observation is scheduled or not.  To edit an existing observation segment definitions, select an entry in this list.

Table 4.2.3. Status Codes

	Status Value
	Short Name
	Description

	
	blank
	The observation is not scheduled

	t
	trailing 
	The observation starts before the window of interest and the entire observation is scheduled. 

	t p
	trailing, partial. 
	The observation starts before the window of interest and the observation is not completely scheduled.

	s
	scheduled
	The observation starts within the window of interest and the entire observation is scheduled. 

	s p
	scheduled, partial
	The observation starts within the window of interest and the observation is not completely scheduled.

	f
	future
	The observation starts after the window of interest and the entire observation is scheduled. *

	f p
	future, partial
	The observation starts after the window of interest and the entire observation is not completely scheduled.*

	* Having an observation start in the future is not normal.  This can happen only if you set the schedule time range earlier than your last planning period.  This is not recommended.  If you need to go back in time, it is best to unschedule the snapshots in the current period before going back. The main problem occurs when you advance the schedule times again. The remaining snapshots may interfere with the new observations that you scheduled.


4.2.4.
Edit Constraints

The constraint definitions should rarely need to be changed.   Do not delete any of the delivered constraints. The roll, sunlimit, moonlimit, occult, and ramlimit constraints define basic scheduling requirements. Other constraints, such as the time critical (TC) constraint may be defined to restrict scheduling during certain time periods.  The values for the fields are defined in the Science Target Database Design document.  

The editor can be used to create a new constraint definition, to change an existing definition, or to make a new constraint based on an existing definition. When creating a new constraint, type the field values into the appropriate text entries and press the Add button. To update a definition, select the definition from the window.  The editor pane entries will be populated will the current values. Make the desired changes and press the Add or Change button. 

A field value is validated when you press Tab or Enter.  Tab also advances the cursor to the next field. Selecting a new field with the mouse does not run the validation function for the field you left.  The validation functions are run again when the Add or Change button is clicked.  
The Add button is used when the Name or Targets fields are changed.  

The Change button is used to replace the existing definition with the changed values.

The Restore button is used to undo the changes made to the selected constraint.  It is identical to selecting the definition entry from the list again.
The Delete button is used to remove constraints.   You will typically remove out-of-date TC constraints.

The Help button is not implemented.
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Figure 4.2.4. Constraint Definition Editor Panel
Appendix A. Installation

This user guide assumes that TAKO has been installed.  Installation has three steps:

1.  Load the delivered software

2.  Populate the MOC file server directories (create if necessary)

3.  Set up the SOT user account.

Details are given in the Installation Notes for the current build.  A summary is given here to help troubleshooting.

After installation, this is what the user should see:

1.  Load the delivered software

See that the TAKO software resides in /home/swiftins/MOC_current/moc/Tako

2.  Populate the MOC file server directories (create if necessary)

See that directories were created under /filesvr/ops_ mocfilesvr

See that TAKO configuration file (tako.init) is installed in the MOC file server directory, $FS_MOC_CONFIG.  Check that the TakoData keyword is set the path for the TAKO data directory location ($HOME/TAKO.dat).  

3.  Set up SOT user account.

a. 
The .profile file has been set up as follows:

export MOCFILESERVER=/filesvr/ops_mocfilesvr

export MOCINSTALLDIR=/home/swiftins/MOC_current/moc

export PATH=$PATH:$MOCINSTALLDIR/Tako/

. $MOCINSTALLDIR/config/mocenvrc  # set MOC environment
# full path of the base installation directory for TAKO

export TAKO=$MOCINSTALLDIR/Tako 
export TAKOBASE=$TAKO/lib         # TAKO software directory
# full path of TAKO data directory

export TAKODATA=$HOME/TAKO.data  
alias runtako="$TAKO/bin/tako init=$FS_MOC_CONFIG/tako.init"

b.  
The TAKO data directory has been created.

GLOSSARY
goodtime 1) when applied to scheduling a target.  It refers to the time blocks during which none of the observing constraints are violated.

2) in defining constraints, it is a resource that is debited when the constraint is violated.
MJD is the acronym for Modified Julian Date.

Modified Julian Date is a time and date format was introduced by space scientists in the late 1950's.  The Modified Julian Date gives the number of days since midnight on November 17, 1858. This date corresponds to 2400000.5 days after day 0 of the Julian calendar, hence it is called Modified Julian Date. The time of day is represented as a fraction of a day.
observation is used in this document as a shorten form of observation segment

observation list (also called "target list") is the current set of observation segment definitions. 

observation segment definition contains parameters that define observation segment: the target location, spacecraft roll angle, and instrument modes.  A target may have several observation segments defined for it.

POW is the software component that implements the timeline plots. 

snapshot is a portion of an observation segment that can be made while observation constraints are not violated.

target is a location in the sky given as right ascension and declination.  
TAKO  Issues:
1.  Behavior of scheduler when a snapshot is the maximum snapshot duration, but the good time is longer.  Currently, the scheduler starts another snapshot of the same target immediately after the long one.  This should be good for the UVOT instrument since it allows it to restart its filter cycle, but this may not be what is expected or desired.

2.  Format of the database report is probably not useful as is.   Need input from user on format and any simple summary statistics that would help evaluating the schedule. Remember, these statistics are for the current schedule only and can't include previous schedules.

3. Ignore target and Lock target functions were not completely implemented in the legacy TAKO.  They sound like good features (even though they are not described in any design document.)  I guess Ignore target would mean that the scheduler should not put this target in the autoschedule target list, and Lock target would mean don't allow this target to be rescheduled (moved or unscheduled).  The only part that is currently implemented is the part that marks the targets as "ignore" or "lock".   It would be trivial to implement if this feature would be useful.
4. Load Chain/Monitoring is not completely implemented in the legacy TAKO.  In fact, the chains.tcl source code has syntax errors. Needs further investigation into whether this feature would be useful for Swift.  

5. Currently, the Fill-in target set (40 targets) must be manually updated every 20 days to have a good roll angle.  Is it worth having an automated way to update the Fill-in targets?

6. The Delete and Archive functions in the Target Database Editor do not have an Undo feature. Implement Undo or guard it with an (annoying) "Are you sure?" dialog?
7. The "Declining Merit" scheduling function has not been implemented, but the supporting data items are defined in the database.  They are not used in Release 2.
i
PAGE  
iii

_1104216565.vsd
�

�

User�

�

Preplanned Science
Timelines�

Main Window�

�

Observations�

�

�

TAKO�

Scheduler�

Target Databases
(observation segment definitions,  
constraint definitions, scheduled snapshots)�

Target Database Editor�

Constraints�

Ephemeris file name, 
Constraint Definitions�

POW�

Plots�

Control�

Data�

Constraint Data�

Ephemeris
files�


_1102487922.vsd

